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Specifications 
 

 
Copyright 2013 © 

Designed and 

Manufactured In:

12 x 8 x 12 inch

300 x 200 x 300 mm

24 x 17.5 x 18 inch

610 x 445 x 460 mm

38 lbs

17 kg

Material that can 

be printed:

Filament 

Diameter

Nominal: 3.00mm               

Actual: 2.85 ± 0.1mm
mm

Nozzle Diameter 0.5 and 0.35 mm

0.06 mm

0.0024 inch

150 mm/s

5.91 inch/s

400 mm/s

15.75 inch/s

Circuit Board

Bed

Frame

Display

Power Supply

File Format

System 

Compatibility

Matter Control & Repetier-Host

Cura & Slic3r

RAMBo

Temp Controlled Heated Bed

C
o

m
p

.

Software

Netfabb & MeshLab

Windows, Mac, Linux

STL & GCODE

G
e

n
e

ra
l

Partially Enclosed Acrylic

VIKI LCD ScreenH
a

rd
 

w
a

re

Printer Size 

(LxWxH)

Internal auto-switching 13.5V DC, 300W

Weight

USA

ABS, PLA, Soft PLA, PLA 4043D, BendLay, 

LayWOO D-3, Laybrick, HIPS, T-Glase, 

PVA, Nylon, TPE & more to come!

Build Volume 

(LxWxH)

Minimal Layer 

Thickness

Max Speed-

Perimeter

Max Speed-

Travel

S
p

e
cs

.
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Unboxing the Printer 
Box Contents 
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Part Directory 
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How it Works 
Extruder Assembly 

 
Hot End and Heat Bed Motion 
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Plug In & Turn On 
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Pre-Printing Steps 
Quick Start Guide 
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Quick Start Guide (contd.) 
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1) Leveling the Heat Bed 
 

Why Level the Heat Bed- One of the most important steps in 3D printing is how the first layer prints.  

Like building a house, the first layer is the foundation for the remainder of your print.  Without a level 

bed, your print will be marginal at best. Because of the configuration of the printer, the heat bed only 

moves slowly in the Z direction. This means that the heat bed tends to stay reasonably level over time. 

The better the calibrated printer, the more efficient the printing process is. Calibrating the printer 

should be done once a month or so and when traveling with the printer in a car. This will insure that 

ƚŚĞ ŶŽǌǌůĞ ĚŽĞƐŶ͛ƚ ƌƵŶ ŝŶƚŽ ƚŚĞ ďĞĚ ĂŶĚ ƚŚĂƚ ƚŚĞ ĂĐĐƵƌĂĐǇ ŽĨ ƚŚĞ ƉƌŝŶƚĞƌ ƐƚĂǇƐ ŝŶƚĂĐƚ͘  
 

Basic Concept to Level the Heat Bed- There are two parts to leveling the heat bed. The first part is to 

make sure that the XY plane (the plane that the nozzle moves in) is parallel to the heat bed (glass). This 

is achieved by the four small M3 screws in each corner of the heat bed. The second part is the first 

layer height. This is achieved by the Z-adjustment screw and limit switch subassembly for the heat bed. 

The Z-adjustment screw is labeled on the Part Directory page. This spring loaded screw initiates the 

limit switch (Z-min) and sets the first layer height. 

 

Steps to Leveling the Heat Bed- On the micro SD card, there is a Calibration Print. Run this calibration 

print to level the heat bed. There is also a video on our website that is a step by step guide along for 

this calibration. We highly recommend that you run this print before trying to print out parts. Your 

success rate is highly dependent on how level your heat bed is. The quick start guide will also have the 

steps written out as well. The next two pages have a step-by-step guide for calibrating the printer. 

 

Once you have calibrated the printer, we highly recommend that you run a few sample prints before 

moving on to custom prints. This will ensure that the printer is working correctly. Also you will gain 

valuable knowledge from this. For one, you will understand how the printer works before having to 

dive into the settings. And secondly, you will have the opportunity to see some massive prints that 

very few printers can print. Plus you get to show off to your family, friends, coworkers and boss the 

incredible sample parts. 
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First Print & Calibration 
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First Print & Calibration (contd.) 
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2) Loading Filament 
 

Good quality filament will be 2.85 ± 0.10mm in diameter. If the filament is consistently over 3.00mm, 

you may want to purchase the material from somewhere else. 
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3) Elmerǯs Glue OR GOO 
For ABS prints, a PURPLE EůŵĞƌ͛Ɛ GůƵĞ ƐƚŝĐŬ ĐĂŶ ďĞ ĞǆƚƌĞŵĞůǇ ŚĞůƉĨƵů ŝŶ ŬĞĞƉŝŶŐ ǇŽƵƌ ƉĂƌƚƐ ƐƚƵĐŬ ƚŽ ƚŚĞ 
bed. This is very important in keeping the part from warping or curling during the print. The PURPLE 

EůŵĞƌ͛Ɛ GůƵĞ ƐƚŝĐŬ ĐĂŶ ďĞ ĂƉƉůŝĞĚ on top of the PET film as the bed is heating up. It only needs to be 

applied where you are printing your part. 

GOO is a different way of helping your parts to stick. GOO is a solution of natural ABS sticks and 

Acetone in a glass jar. The mixture in the jar should look murky. When your bed is heating up, saturate 

a piece of paper towel and wipe the bed. This will be applied on top of the PET film (green) that is 

already on your glass. The area of the glass where the GOO is applied should have a white frost look to 

it.  

EITHER USE THE PURPLE ELMERS GLUE STICK OR THE GOO, BUT NOT BOTH. 

 

4) The First Layer 
Why- The first layer is by far the most important layer of your entire print. If your first layer is 

successful, you have a very good chance of having a successful print. The first layer height is controlled 

by the Z-adjustment screw which is spring loaded and in the back left corner of the top panel. The bed 

raises and initiates the limit switch to set the first layer height. Once your bed is level, there are a 

couple steps to getting a good first layer. 

How To- First turn the Z-height-adjustment screw clockwise a half turn with your 2.5mm allen wrench. 

Next, move your nozzle to the center of your bed. Then home the Z-axis. The bed will raise and initiate 

the limit switch. At this point, the nozzle should be off the bed. Turn the Z-height-adjustment screw 

counter clockwise a quarter turn. And once again home the Z-axis. Repeat this process until your nozzle 

is just off the bed. 

Nozzle Too High- If you run a print with the nozzle too high, the filament will just lie on the glass and 

not stick. Turn the Z-adjustment screw counter clockwise. This means the Z limit switch to be activated 

later, and there for the nozzle is closer to the glass. Home the Z again and repeat until the nozzle is just 

off the bed. 

Nozzle Too Low- If you run a print with the nozzle too low, the filament will have no room to come out 

of the nozzle and seem to clog. If this does happen, raise the nozzle off the bed at least 3 inches, make 

sure your nozzle is heated to at least 245C, and extrude material. Then turn the screw clockwise. Home 

the Z again and repeat until the nozzle is just off the bed. 

Nozzle Height is Just Right- The first layer should look like a pancake. The nozzle should be extruding 

the material and smooshing it into the glass. 

***This can be done during the first layer of the print with the Z threaded rod (the threaded rod 

attached to the Z-motor). This assumes that the bed has already been leveled. If the nozzle is too close 

to the glass, turn the Z threaded rod counter clockwise to lower the bed. If the nozzle is too far from 

the glass, turn the Z threaded rod clockwise to raise the bed. This should be no more than 1/8 of a turn 

or so. NOTE that this action will only offset the first layer for the current print. If run again, the 

adjustment will not have effect. 

 

5) LED Lights 
The LED lights will turn on automatically when your print starts and turn off when your print ends. But 

you can manually turn on the lights. ͞MϰϮ Pϲ “Ϯϱϱ͟ ǁŝůů ƚƵƌŶ ƚŚĞŵ ŽŶ, ͞MϰϮ Pϲ “Ϭ͟ ǁŝůů ƚƵƌŶ ƚŚĞm off.  
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VIKI LCD Screen 
VIKI: Introduction 
Out of the many features the VIKI LCD Screen has, there are four main ones that you will use regularly.  

They include Auto Home, Preheat ABS, Move Axis and Print from SD. The following page has a layout 

of all the features the VIKI has to offer and these four functions are underlined. 

Auto Home- Auto Home (AKA the origin) will use the min limit switches to move the nozzle to the front 

left corner, and the bed to the top. Home is very important because that is where every print will start 

from.  

Preheat ABS- Preheat ABS is a great feature for preheating your printer before printing. When you are 

done designing, slicing, and loading your SD card, your printer is ready to go.  

Move Axis- Move Axis allows you to manually move the nozzle and bed in each direction. 

Print from SD- Print from SD is where you can access the GCODE files on your micro SD card. We have 

already loaded a library of sample prints for you to run right away. 

 

VIKI: Home Screen 
This is the home screen for the VIKI LCD Screen. There are two heated components on the printer, the 

nozzle and the bed. Both actual and target temperatures are displayed. TŚĞ ͞PO“ITION͟ ŝƐ ƚŚĞ ĐƵƌƌĞŶƚ 
ƉŽƐŝƚŝŽŶ ŽĨ ƚŚĞ ŶŽǌǌůĞ ƌĞůĂƚŝǀĞ ƚŽ ŝƚƐ ŚŽŵĞ ƉŽƐŝƚŝŽŶ͘ TŚĞ ͞FEED ‘ATE͟ ŝƐ Ă ŵƵůƚŝƉůŝĞƌ͘ Aƚ ϭϬϬй͕ ƚŚĞ 
printer is running exactly what the GCODE is instructing it to do. If the feed rate is increased or 

decreased, the printer will speed up or slow down in every direction. To change the federate, turn the 

dial on the VIKI home screen and watch the percent change. It is not recommended to go any faster 

when using the fast settings. The SD Card _ _% is how full your micro SD Card is. TŚĞ ͞TŝŵĞ͟ ŝƐ ƚŚĞ 
amount of time that the printer has been printing its current job. 
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VIKI: Layout 
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VIKI: How To  
 

The four main functions of the VIKI LCD screen are to prepare for a print, manual control, run a print 

and control the printer during a print. Use the layout on the previous page as a road map to find each 

function. To go from row to the row, simply click the center button. Use the scroll wheel to move left 

and right in the road map. If left idle for 15 seconds, the VIKI will return to the home screen.  

 

Prepare- TŚĞ ŵĂŝŶ ĨƵŶĐƚŝŽŶƐ ƵƐĞĚ ƵŶĚĞƌ ͞PƌĞƉĂƌĞ͟ ĂƌĞ ͞AƵƚŽ HŽŵĞ͕͟ ͞PƌĞŚĞĂƚ AB“͕͟ ĂŶĚ ͞MŽǀĞ AǆŝƐ͘͟ 
͞AƵƚŽ HŽŵĞ͟ ǁŝůů ŝŶƐƚƌƵĐƚ ƚŚĞ ƉƌŝŶƚĞƌ ƚŽ ŵŽǀĞ ƚŚĞ ĞǆƚƌƵĚĞƌ ƚŽ ŚŽŵĞ ŝŶ ĞĂĐŚ direction (X, Y, Z). The 

home for the printer is essentially the origin in the XYZ coordinate system. ͞PƌĞŚĞĂƚ AB“͟ ǁŝůů ƚƵƌŶ ŽŶ 
both heaters for the extruder and bed to near the printing temperatures of ABS. This way, when your 

start your print, the temperatures may just have some minor changes if needed.  

  

Manual Control- UŶĚĞƌ ͞PƌĞƉĂƌĞ͕͟ ƚŚĞƌĞ ŝƐ ͞MŽǀĞ AǆŝƐ͘͟ OŶĐĞ ƐĞůĞĐƚŝŶŐ ĂŶ ŝŶĐƌĞŵĞŶƚ ĂŶĚ ĂǆŝƐ͕ ƚŚĞ 
extruder and bed can be manually controlled by the user. This also includes the extruder. This function 

can be used to purge the machine of a previous material or color. When changing materials, purge 

between 500 and 1000mm to completely get rid of the old material. (Also see the material section for 

further instructions about different materials) 

 

Print from SD- ͞PƌŝŶƚ ĨƌŽŵ “D͟ ƵƚŝůŝǌĞƐ GCODE ĨŝůĞƐ ƚŽ ƌƵŶ ƚŚĞ ƉƌŝŶƚĞƌ͘ OŶĐĞ ĂŶ “TL ĨŝůĞ ŝƐ ƐůŝĐĞĚ ĂŶĚ 
GCODE is created, it can be saved onto the micro-SD card. Keep in mind that once a part is sliced, that 

GCODE file is for a specific material (temperatures, speeds, etc.) 

 

Tune- There are a few things that can be altered during the print by using the VIKI LCD screen. One of 

them is speed or feed rate. This will speed up or slow down a print. The rule of thumb is not to go any 

faster than fast settings and not any slower than slow settings. At 100%, the printer is running the 

GCODE exactly, utilizing the settings. Above 100%, the printer will increase its speed; below 100%, the 

printer will decrease its speed. It is not recommended to increase the feed rate higher than 125% or 

lower than 75%. This is mainly because of the retraction in the bowden system. The other way to 

increase or decrease the speed during a print is to spin the wheel while looking at the home screen; 

this will cause the feed rate value to change accordingly. The nozzle and bed temperatures can also be 

altered during the print. Some times for big or tall parts, it may be useful to increase the bed 

temperature a little. The fan speed is only used for materials that would require fans (refer to 

͞MĂƚĞƌŝĂůƐ “ĞůĞĐƚŝŽŶ͟Ϳ͘ ABS does NOT need the fans.   
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RAMBo Driver  
Setup (Windows 8 Only) 
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Installation (PC Only) 
1) Only PC computers need the RAMBo Driver. 

2) Plug your printer into your computer with the USB cable.  Also insert the Airwolf USB stick 

provided with the printer. 

3) IŶ ƚŚĞ ͞CŽŶƚƌŽů PĂŶĞů͕͟ ŽƉĞŶ ƵƉ ͞DĞǀŝĐĞ ĂŶĚ PƌŝŶƚĞƌƐ͘͟  UŶĚĞƌ ͞UŶƐƉĞĐŝĨŝĞĚ͕͟ ǇŽƵ ƐŚŽƵůĚ ƐĞĞ Ă 
ĚĞǀŝĐĞ ůĂďĞůĞĚ ͞‘AMBŽ͘͟  ‘ŝŐŚƚ ĐůŝĐŬ ƚŚĞ ĚĞǀŝĐĞ ĂŶĚ ƐĞůĞĐƚ ͞PƌŽƉĞƌƚŝĞƐ͘͟ 

 
4) A ƐĞĐŽŶĚ ǁŝŶĚŽǁ ǁŝůů ĂƉƉĞĂƌ͘  UŶĚĞƌ ƚŚĞ ƐĞĐŽŶĚ ƚĂď ůĂďĞůĞĚ ͞HĂƌĚǁĂƌĞ͕͟ ƐĞůĞĐƚ ͞PƌŽƉĞƌƚŝĞƐ͘͟ 

 
5) A ƚŚŝƌĚ ǁŝŶĚŽǁ ǁŝůů ĂƉƉĞĂƌ͘  UŶĚĞƌ ƚŚĞ ĨŝƌƐƚ ƚĂď ůĂďĞůĞĚ ͞GĞŶĞƌĂů͕͟ ƐĞůĞĐƚ ͞UƉĚĂƚĞ DƌŝǀĞƌ͘͟ 
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6) A ĨŽƵƌƚŚ ǁŝŶĚŽǁ ǁŝůů ĂƉƉĞĂƌ͘  “ĞůĞĐƚ ͞BƌŽǁƐĞ ŵǇ ĐŽŵƉƵƚĞƌ ĨŽƌ ĚƌŝǀĞƌ ƐŽĨƚǁĂƌĞ͘͟ 

 
7) “ĞůĞĐƚ ƚŚĞ ͞BƌŽǁƐĞ͟ ďƵƚƚŽŶ͘ 

 
8) Browse for the Airwolf USB ƐƚŝĐŬ͘ “ĞůĞĐƚ ƚŚĞ ĨŽůĚĞƌ ͞‘ĂŵďŽ DƌŝǀĞƌ͟ ĂŶĚ ƐĞůĞĐƚ ͞OK͘͟ 

 
9) TŚĂƚ ǁŝŶĚŽǁ ǁŝůů ĐůŽƐĞ ĂŶĚ ƌĞƚƵƌŶ ƚŽ ƚŚŝƐ ƐĐƌĞĞŶ͘  “ĞůĞĐƚ ͞NĞǆƚ͘͟ 
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10) AŶŽƚŚĞƌ ƐĐƌĞĞŶ ŵĂǇ ĂƉƉĞĂƌ ĂŶĚ ƐĂǇ ͞WŝŶĚŽǁƐ ĐĂŶ͛ƚ ǀĞƌŝĨǇ ƚŚĞ ƉƵďůŝƐŚĞƌ ŽĨ ƚŚŝƐ ĚƌŝǀĞƌ 
ƐŽĨƚǁĂƌĞ͘͟  “ĞůĞĐƚ ͞IŶƐƚĂůů ƚŚŝƐ ĚƌŝǀĞƌ ƐŽĨƚǁĂƌĞ ĂŶǇǁĂǇ͟ 

 
11) IĨ ŝŶƐƚĂůůĞĚ ĐŽƌƌĞĐƚůǇ͕ ƚŚŝƐ ŝƐ ƚŚĞ ƐĐƌĞĞŶ ǇŽƵ ƐŚŽƵůĚ ƐĞĞ͘  “ĞůĞĐƚ ͞CůŽƐĞ͕͟ ͞CůŽƐĞ͕͟ ĂŶĚ ͞OK͘͟ 

 
12) NŽǁ ŝŶ ǇŽƵƌ ͞DĞǀŝĐĞƐ ĂŶĚ PƌŝŶƚĞƌƐ͕͟ ƵŶĚĞƌ ͞UŶƐƉĞĐŝĨŝĞĚ͕͟ ƚŚŝƐ ŝƐ ƚŚĞ ƐĐƌĞĞŶ ǇŽƵ ƐŚŽƵůĚ ƐĞĞ͘ TŚĞ 

͞;COMϭϳͿ͟ ŝƐ ĚĞƉĞŶĚĞŶƚ ŽŶ ǁŚĂƚ U“B ƉŽƌƚ ǇŽƵ Ɖůugged the printer into.  So yours may display a 

different COM number. 
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5 Steps to Printing 
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1) Download or Design a 3D Model 
 

There are a couple of websites where you can download 3D models. Thingiverse is a great place to find 

STL files to print. Another place to find 3D models is GrabCad. GrabCad has many models for many 

different CAD programs. There are a couple things to consider when selecting or designing a 3D model. 

 

Orientation- The orientation of your part is critical to a successful print. Different orientations will 

produce a difference in strength, print time, appearance and success rate. Definitely envision the 

orientation of your part as you are designing the part, feature by feature. This will greatly enhance 

your printing experience. 

 

Support Material- There are three ways to approach support material. The best way is to design and 

orient your part so that it does not need any support. The next best option is to design your own 

supports into the part. This way there is only support where you want it and it is easy to remove. Also 

you can control how thick the supports are as well. The last way is to have the slicing program 

͞ŐĞŶĞƌĂƚĞ ƐƵƉƉŽƌƚ ŵĂƚĞƌŝĂů͟ ǁŚĞƌĞ ŶĞĞĚĞĚ͘ TŚŝƐ ŝƐ ŚĞůƉĨƵů ǁŚĞŶ ŽƉƚŝŽŶƐ ŽŶĞ ĂŶĚ ƚǁŽ do not work 

sufficiently. This is the most extensive method of printing. It takes time and patience. 

 

Settings- As far as settings go, we recommend that you import the settings from the USB stick that was 

provided with the printer. These are already preconfigured settings for each of the materials. Quite 

regularly we update the material settings, so send us an email for the latest version of settings. 

Another thing to consider while designing is what settings you will ultimately use to slice the part 

(fast/slow, solid/hollow, etc). One way that you will select settings is by the application of your part. 

For parts under stress or heat, you may want to select slow print settings and make it almost 

completely solid. For parts like sculptures or statues where there is almost no physical function of the 

part, you may select fast and hollow settings.  

 

Material Selection- Material plays a big part in the application of your part. ABS is by far the easiest 

and cheapest printing material. It can take physical and thermal stresses quite well and can be post 

processed easily. TƵƌŶ ƚŽ ƚŚĞ ͞MĂƚĞƌŝĂůƐ “ĞůĞĐƚŝŽŶ͟ ƐĞĐƚŝŽŶ Ĩor a more in depth introduction to the 

different materials. 
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2) Convert to STL File Type 
 

STL is a file type created specifically for 3D printing. All modern 3D Printers, desktop and industrial, use 

the STL file format and it is therefore transferable between various 3D Printing operating programs. It 

stands for Standard Tessellation Language but is commonly mislabeled as Stereolithography. STL files 

are composed of data points in three dimensional space and triangles linking those data points, 

therefore creating a mesh. It is important that this mesh is clean and watertight so the slicing software 

can properly interpret the data, the next section covers how to ensure a clean watertight mesh. 

 

When exporting an STL from your CAD program it is important to make sure your settings are not 

unnecessarily high resolution. Creating very high resolution STLs can often times cause processing 

delays and issues when slicing or printing. It is good practice to generate STL files with parameters 

tailored to the capabilities of your machine. 

 

Recommended settings for the HD are as follow: 

 

Deviation Tolerance: 0.05mm or greater 

Angle Tolerance: 5 degrees or greater 

 

3) Netfabb: Layout (STL Clean Up) 
 

Having a clean STL file is crucial to a successful slice and eventually a successful print. Depending on the 

CAD program used to design the 3D model, and also the complexity of the 3D model, some create the 

STL file cleaner than others. But just to be safe, it is a good rule of thumb to clean up your STL file. Also, 

this is a great place to check to make sure the part is in the printing orientation. You can also check to 

make sure your CAD program exported it correctly size wise. Also this is a program to make sure your 

“TL ĨŝůĞ ŝƐ ͞ǁĂƚĞƌƚŝŐŚƚ͟ for printing correctly. This is especially important when designing in CAD 

programs like SketchUp. If you do change the units in Netfabb from millimeters to inches, make sure to 

switch it back to millimeters before exporting the STL file.  
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3) Netfabb: How To (STL Clean Up) 
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4) Slicing 
 

Slicing is what 3D printing is all about. SlicŝŶŐ ŝƐ Ă ƉƌŽĐĞƐƐ ŝŶ ǁŚĞƌĞ ƚŚĞ “TL ĨŝůĞ ŝƐ ͞ƐůŝĐĞĚ͟ ŝŶƚŽ ƚŚŝŶ ůĂǇĞƌƐ 
for the printer. There are three parts to this process; the STL file, the settings, and the GCODE. The 

slicing engines that are utilized are Slic3r or Cura. They create GCODE and are incorporated in 

MatterControl and Repetier-Host. These two programs take the GCODE and run the printer with it. 

Only one program at a time is needed to run the printer.  

 

The time taken to slice an STL file is dependent on the complexity of the geometry, the settings 

selected and the computing power of your computer. If Slic3r is having trouble slicing your part, try 

using Cura. Cura can usually slice just about anything. 

 

As you begin to learn about the slicing engines and how they work, the best way is to load preset 

settings from the USB stick. As you start getting more experienced, you can start adjusting certain 

settings to increase the quality of your specific parts. 

 

Some General Settings for the HD printer (these are already included in our preset settings): 

Retraction Length = 7mm 

Retraction Speed = 50mm/s 

HD Layer Height = a multiple of 0.03mm- ACME lead screw (0.06, 0.09, Ϭ͘ϭϮ͙ ƵƉ ƚŽ Ϭ͘ϯϵŵŵ) 

HDx Layer Height = a multiple of 0.02mm ʹ ACME ůĞĂĚ ƐĐƌĞǁ ;Ϭ͘Ϭϰ͕ Ϭ͘Ϭϲ͕ Ϭ͘Ϭϴ͙ ƵƉ ƚŽ Ϭ͘ϰϬŵŵͿ 
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Slicing: Breakdown 
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4-5) MatterControl PRO: How To 
 

MatterControl Pro is an all-ŝŶĐůƵƐŝǀĞ ƉƌŽŐƌĂŵ ƵƐĞĚ ƚŽ ͞ƐůŝĐĞ͟ ǇŽƵƌ “TL ĨŝůĞ and convert it into GCODE to 

run the printer. TŚŝƐ ŝŶĐůƵĚĞƐ ƐƚĞƉƐ ϰ ĂŶĚ ϱ ĨƌŽŵ ƚŚĞ ͞ϱ “ƚĞƉƐ ƚŽ PƌŝŶƚŝŶŐ͘͟ MatterControl Pro includes 

Slic3r and Cura as its slicing engines. From time to time, check to see if there is an updated version of 

MĂƚƚĞƌCŽŶƚƌŽů PƌŽ͘ TŚŝƐ ĐĂŶ ďĞ ĚŽŶĞ ŝŶ ƚŚĞ ͞PƌŝŶƚĞƌ QƵĞ͟ ƐůŝĚĞ͕ ƵŶĚĞƌ ƚŚĞ ͞AďŽƵƚ͟ ƚĂď͘ MĂŬĞ ƐƵƌĞ ǇŽƵ 
are connected to the internet to have access to the new updated version. 
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4-5) MatterControl PRO: How To (contd.) 
 

Once you have connected to your printer, the next steps are to add an STL file, preheat the extruder 

and bed, and import slice settings. Export the GCODE from MC to an SD card to print from the VIKI. 
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4-5) Repetier Host: Setup 
 

Repetier Host is a similar program to MatterControl PRO. It utilizes Slic3r as its slicing engine and is 

used to run the printer. 
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4-5) Repetier Host: The Basics 
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4-5) Repetier Host: How To 
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4-5) Repetier Host: How To (contd.) 
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Material Selection 
Materials: Comparison 
Here at Airwolf 3D, we do not manufacture 3D printing materials. Some companies we recommend 

would be Ultimachine and IC3D for ABS, MatterHackers for specialty material, Ninja Flex or Fenner 

Drives for TPE, and Taulman 3D for Nylon. When we construct new settings for new materials, they will 

be available to you, regardless of the time of your purchase. Send us an email and we will reply with 

the latest settings. 
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Materials: Comparison (contd.) 
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Materials: Settings 
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Materials: Settings (contd.) 
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Post Processes 
Acetone Vapor 
(PROCEED WITH CAUTION) 
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Two Part Epoxy 
A company called BJB makes an epoxy called TC-1614 A/B. This is what is referred to in the following 

instructions. More detailed instructions are included with the purchase of their epoxy. 
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Firmware 
 

TŚĞ HD ĨŝƌŵǁĂƌĞ ŝƐ ĐĂůůĞĚ ͞Marlin_HD_23͘͟ (If there is something newer, use it instead) The firmware 

is the communication link between the software and hardware. The firmware is already uploaded to 

your printer. Only alter the firmware if you have past experience or are directed to by an Airwolf 

technical assistant. 

 

Before Starting- make sure your power cable is plugged into the wall and the printer is plugged into 

your computer. Also you must have the printer turned on and that your RAMBo driver is installed 

correctly.  

1) Download everything from the firmware folder either on the USB stick or the Dropbox link. 

2) Install Arduino 0023 

a. If you already have it, make sure you ŚĂǀĞ ƚŚĞ ͞LiquidTWI2͟ ĨŽůĚĞƌ ŝŶ ͞LŝďƌĂƌŝĞƐ͟ 

3) Open up Arduino 0023 

a. If it asks you to install ƚŚĞ ůĂƚĞƐƚ ǀĞƌƐŝŽŶ͕ ƐĞůĞĐƚ ͞NO͟ 

4) Select File > Open > Marlin_HD_23 and seůĞĐƚ ƚŚĞ ͞CŽŶĨŝŐƵƌĂƚŝŽŶ͘Ś͟ ĨŝůĞ 

5) A new screen will open up with all of the new firmware 

a.  
6) Select Tools > Board > Arduino Mega 2560 

7) Select Tools > Serial Port > COM## 

a. Select the COM Port for your HD printer. If you are not sure which COM## it is, it can be 

ĨŽƵŶĚ ŝŶ ƚŚĞ ͞DĞǀŝĐĞƐ ĂŶĚ PƌŝŶƚĞƌƐ͟ ƐĞĐƚŝŽŶ ŽĨ ǇŽƵƌ ĐŽŵƉƵƚĞƌ͘ 
8) There are 7 buttons at the top, select the 6th ŽŶĞ ůĂďĞůĞĚ ͞UƉůŽĂĚ͘͟ IĨ ĚŽŶĞ ĐŽƌƌĞĐƚůǇ͕ ŝƚ ƐŚŽƵůĚ 

ƐĂǇ ͞DŽŶĞ UƉůŽĂĚŝŶŐ͘͟ 
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Maintenance 
Here at Airwolf 3D, we have already done these maintenance steps. These should be done periodically 

(about every 100 printing hours) to ensure a working printer. 
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Belt Tensioning 
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Rod Alignment (X-axis) 
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Rod Alignment (Y-axis) 
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Rod Lubrication 
 

Use Lithium Grease on all the metal rods (labeled in red) on the first maintenance page. 

 

 
 

 

Inserting Filament 
 

At first, you may have trouble inserting the filament. There are two usual places where this may occur; 

the extruder motor/hobbed bolt or the top of the hot end.  

 

If you are having trouble inserting the filament into the extruder motor, pull the pin, and release the 

spring loaded latch. Next, slide the white plastic adapter out to the right. Then fish the filament 

through the extruder motor from the bottom and manually feed it into the white adapter. Reinsert the 

white adapter into the extruder assembly and close the spring loaded latch. Finally insert the pin. 

 

If you are having trouble inserting the filament into the top of the hot end, you will need to remove the 

retaining ring. Use a pair of pliers to remove the retaining ring and carefully pull out the PFT tube. 

Manually insert the filament into the white adapter and reinsert the PFT tube. Finally reattach the 

retaining ring back onto the white adapter. 
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Wiring Diagram 
Motor- X, Y, Z1, and E0 

Limit Switches- All 6 limit switches are used 

Heaters- Heat 0 is for the extruder (heating element), Heat2Bed is for the heat bed 

Thermistors- T0 is for reading the extruder temperature, T2 is for reading the heat bed temperature 

Fans- Fan 0 is for the extruder fan, Fan 1 is for the LED lights 

Fuses- Motor Fuse, Heating Element Fuse (Nozzle), and Heat Bed Fuse 

 RAMBo has 3 replaceable fuses. The small white fuse holders are Little Fuse OMNI-BLOCK fuse 

holders. They are compatible with NANO2 Fuses. Fast or very fast acting are recommended. An 

example part number for replacement fuses is 0448005.MR 

VIKI LCD Screen- I2C(1-4), SPI(3-6), EXT(13, 15, 17, 19) 

VIKI WIRING  

Wire Color Cable A Cable B 

RED I2C 4 SPI 6 

BLACK I2C 3 EXT 13 

BLUE I2C 2 SPI 4 

GREEN I2C 1 SPI 5 

YELLOW EXT 17 EXT 15 

WHITE EXT 19 SPI 3 
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Clogged Nozzle 
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Changing the Nozzle 
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Trouble Shooting 
 

1) How do I convert my Sketchup file into an STL file? 

a. Use the plug-in and instructions from our website. http://airwolf3d.com/wiki/how-to-

convert-and-export-google-sketchup-skp-files-to-stl-for-3d-printing/ 

2) What settings do I use for the printer? 

a. Use the configurations that are on the USB stick. Configurations are a group of settings 

(speeds, temperatures, resolution, etc.)  

3) What are some general settings for all prints? 

a. First Layer Height = .4mm 

b. AB“ TĞŵƉĞƌĂƚƵƌĞƐ͗ ;NŽǌǌůĞ ш ϮϰϬCͿ ;BĞĚ ш ϭϭϱCͿ 
4) How do I adjust the Z height? 

a. The M3 screw on the back left corner of the top panel. This screw sets the first layer 

height. 

5) WŚĂƚ ĚŽ I ĚŽ ŝĨ ŵǇ ƉĂƌƚ ŝƐŶ͛ƚ ƐƚŝĐŬŝŶŐ͍ 

a. MĂŬĞ ƐƵƌĞ ƚŽ ƵƐĞ ƚŚĞ ƉƵƌƉůĞ ĞůŵĞƌ͛Ɛ ŐůƵĞ ƐƚŝĐŬ on your glass. The rule of thumb is to 

print until your part does not stick; then apply the mixture. Also, increasing the bed 

temperature slightly should help with the stick. 

6) What filament diameter can be used on the printer? 

a. ONLY 3mm diameter filament (2.85mm +- 0.10mm measured) can be used on the 

printer. 

7) There are fans next to my nozzle. When do I use them? 

a. Fans are NOT needed for ABS. PLA is a material that needs fans. If you use the 

configurations that we give you, fans (ON/OFF) are already accounted for when you slice 

your STL file. The fans are only on at 100% (255), anything lower than this will cause the 

fans to turn off. 

8) I think my nozzle is clogged. How do I know and what do I do if it is clogged? 

a. To see if your nozzle is clogged, raise your nozzle at least 3 inches vertically off the bed. 

MĂŬĞ ƐƵƌĞ ƚŚĞ ŶŽǌǌůĞ ŝƐ ƵƉ ƚŽ ƚĞŵƉĞƌĂƚƵƌĞ ;Ğǆ͘ AB“ ш ϮϰϬCͿ͘ UƐĞ ƚŚĞ ĞǆƚƌƵĚĞ ĨĞĂƚƵƌĞ ƚŽ 
extrude 100mm of material. 

b. If thĂƚ ĚŽĞƐŶ͛ƚ ǁŽƌŬ͕ ǇŽƵ ŵĂǇ ŚĂǀĞ Ă ͞ŵŽƵƐĞ-ďŝƚĞ͘͟ A ŵŽƵƐĞ-bit usually occurs when the 

nozzle is too close to the glass on the first layer. To see, release the extruder latch on 

the back panel and pull the filament out. If there is, cut it off below the mouse-bite and 

reinsert the filament into the extruder. 

9) I ĐĂŶ͛ƚ ƐĞĞŵ ƚŽ ĐŽŶŶĞĐƚ ƚŽ ŵǇ ƉƌŝŶƚĞƌ͘ WŚĂƚ ƐŚŽƵůĚ I ĚŽ͍ 

a. One quick way to solve electrical connecting problems is to unplug the printer from your 

computer, turn of the printer and hit the reset button. This clears the circuit board of 

any errors. With further software issues, please refer to our website, contact us or 

MatterHackers. 

10) Once I have run out of my first roll of material, where can I buy more? 

a. CŽŶŐƌĂƚƐ͊ TŚĂƚ͛Ɛ Ă ůŽƚ ŽĨ ŵĂƚĞƌŝĂů͊ WĞ ĚŽ NOT ƐĞůů material. For ABS, our best 

recommendation is Ultimachine or IC3D.  They make incredible ABS that is tested, roll 

by roll.  MatterHackers is a great source for PLA and specialty filament. Also refer to the 

materials section of this manual. 
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Glossary of Terms 
Hardware 
Filament- Spool of printing material 

Spool Minder- Printed part that holds the spool of material 

Heat Bed- The red plate that heats the glass 

PET Film- The green film on top of the glass for ABS 

Z-Adjustment Screw- Used to adjust the first layer height; located on the top panel in the back left 

(spring loaded) 

 

Extruder- The sub assembly that feeds the material from the spool to the heated nozzle 

Guide Tube- The clear tube that feeds the material from the extruder motor to the hot end 

Hot End- TŚĞ ͞ƉƌŝŶƚ ŚĞĂĚ͟  
Heating Element- The metal block in the extruder that houses a resistor and heats the nozzle 

 

VIKI LCD Screen- On the front panel. Used to control the motion, temps and run prints 

 

Home- Uses the minimum limit switches to find a point of reference (the origin) 

X-axis- Left and right 

Y-axis- Front and back 

Z-axis- Up and down 

 

Software 
STL- The geometry file of the 3D model 

Netfabb- A program used to clean up STL files 

Configurations/Profiles/Settings- Settings used to slice the STL file and create GCODE 

Slicing- Taking and STL file, adding settings and creating GCODE 

Slic3r- A ƉƌŽŐƌĂŵ ƚŚĂƚ ƐůŝĐĞƐ “TL ĨŝůĞƐ ĂŶĚ ĐƌĞĂƚĞƐ GCODE͕ ƵƐĞƐ ͞ĐŽŶĨŝŐƵƌĂƚŝŽŶƐ͟ 

Cura- A ƉƌŽŐƌĂŵ ƚŚĂƚ ƐůŝĐĞƐ “TL ĨŝůĞƐ ĂŶĚ ĐƌĞĂƚĞƐ GCODE͕ ƵƐĞƐ ͞ƉƌŽĨŝůĞƐ͟ 

MatterControl- Developed by MatterHackers. Utilizes Slic3r and Cura to create GCODE. Also used to 

run GCODE. 

Repetier-Host- Utilizes Slic3r to create GCODE. Also used to run GCODE. 

 

Contact List 
Airwolf 3D  

(949) 478-2933                 (949) 478-AW3D 130 McCormick (Suite 112) 

Airwolf3D.com Costa Mesa, CA 92626 

General Information:  info@airwolf3d.com  

Transactional Support:  eva@airwolf3d.com  

Technical Support:  tech@airwolf3d.com  

mailto:info@airwolf3d.com
mailto:eva@airwolf3d.com
mailto:tech@airwolf3d.com
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TERMS OF USE 

 

FAIR USE NOTICE: This directory may contain copyrighted material. Such material is made available for 

informational and educational purposes, to advance understanding of 3D printers, 3D printing, and 

computer-ĂŝĚĞĚ ŵŽĚĞůŝŶŐ ĨŽƌ ϯD ƉƌŝŶƚŝŶŐ͘ TŚŝƐ ĐŽŶƐƚŝƚƵƚĞƐ Ă ͚ĨĂŝƌ ƵƐĞ͛ ŽĨ ĂŶǇ ƐƵĐŚ ĐŽƉǇƌŝŐŚƚĞĚ ŵĂƚĞƌŝĂů 
as provided for in Title 17 U.S.C. section 107 of the US Copyright Law. In accordance with Title 17 U.S.C. 

Section 107, the material on this site is distributed without profit to those who have expressed a prior 

interest in receiving the included information for research and educational purposes. If you wish to use 

copyrighted material from this directory for purposes of your own that go beyonĚ ͚ĨĂŝƌ ƵƐĞ͕͛ ǇŽƵ ŵƵƐƚ 
obtain permission from the copyright owner. 

 

Most of the models contained in this directory are subject to licenses.  The "Thing" No. of the model 

corresponds to the thing as referenced on www.thingiverse.com.  Thingiverse.com idenitifies the 

particular license associated with the specific model.  The licenses can be found at 

http://creativecommons.org/. 

 

THESE MODELS ARE PROVIDED "AS-IS" AND "AS AVAILABLE" AND AIRWOLF 3D (AND OUR SUPPLIERS) 

EXPRESSLY DISCLAIM ANY WARRANTIES AND CONDITIONS OF ANY KIND, WHETHER EXPRESS OR 

IMPLIED, INCLUDING THE WARRANTIES OR CONDITIONS OF MERCHANTABILITY, FITNESS FOR A 

PARTICULAR PURPOSE, TITLE, QUIET ENJOYMENT, ACCURACY, OR NON-INFRINGEMENT. WE (AND OUR 

SUPPLIERS) MAKE NO WARRANTY THAT THE MODELS: (A) WILL MEET YOUR REQUIREMENTS; (B) WILL 

BE AVAILABLE ON AN UNINTERRUPTED, TIMELY, SECURE, OR ERROR-FREE BASIS; OR (C) WILL BE 

ACCURATE, RELIABLE, FREE OF VIRUSES OR OTHER HARMFUL CODE, COMPLETE, LEGAL, OR SAFE. 

 

TO THE FULLEST EXTENT PERMISSIBLE BY THE APPLICABLE LAW, WE HEREBY DISCLAIM ALL LIABILITY 

FOR PRODUCT DEFECT OR FAILURE, CLAIMS THAT ARE DUE TO NORMAL WEAR, PRODUCT MISUSE, 

ABUSE, PRODUCT MODIFICATION, IMPROPER PRODUCT SELECTION, NON-COMPLIANCE WITH ANY 

CODES, OR MISAPPROPRIATION.  

 

TO THE FULLEST EXTENT PERMISSIBLE BY THE APPLICABLE LAW, WE HEREBY DISCLAIM ANY AND ALL 

RESPONSIBILITY, RISK, LIABILITY AND DAMAGES ARISING OUT OF DEATH OR PERSONAL INJURY 

RESULTING FROM ASSEMBLY OR OPERATION OF OUR PRODUCTS.  

 

AIRWOLF 3D ASSUMES NO RESPONSIBILITY, NOR WILL BE LIABLE, FOR ANY DAMAGES TO, OR ANY 

VIRUSES OR MALWARE THAT MAY INFECT YOUR COMPUTER, TELECOMMUNICATION EQUIPMENT, OR 

OTHER PROPERTY CAUSED BY OR ARISING FROM YOUR ACCESS TO, USE OF, OR BROWSING THIS 

WEBSITE, OR YOUR DOWNLOADING OF ANY INFORMATION OR MATERIALS FROM THIS WEBSITE.   

 

Limitation on Liability. IN NO EVENT SHALL AIRWOLF 3D (AND OUR SUPPLIERS) BE LIABLE TO YOU OR 

ANY THIRD PARTY FOR ANY LOST PROFIT OR ANY INDIRECT, CONSEQUENTIAL, EXEMPLARY, 

INCIDENTAL, SPECIAL OR PUNITIVE DAMAGES ARISING FROM OR RELATING TO THESE TERMS OF USE, 

EVEN IF WE HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. ACCESS TO, AND USE OF, 

THE MODELS ARE AT YOUR OWN DISCRETION AND RISK, AND YOU WILL BE SOLELY RESPONSIBLE FOR 

ANY DAMAGE TO YOUR COMPUTER SYSTEM OR LOSS OF DATA RESULTING THEREFROM. 
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NOTWITHSTANDING ANYTHING TO THE CONTRARY CONTAINED HEREIN, OUR LIABILITY TO YOU FOR 

ANY DAMAGES ARISING FROM OR RELATED TO THESE TERMS OF USE (FOR ANY CAUSE WHATSOEVER 

AND REGARDLESS OF THE FORM OF THE ACTION), WILL AT ALL TIMES BE LIMITED TO THE GREATER OF 

(A) FIFTY US DOLLARS ($50); OR (B) AMOUNTS YOU'VE PAID COMPANY IN THE PRIOR 12 MONTHS (IF 

ANY). THE EXISTENCE OF MORE THAN ONE CLAIM WILL NOT ENLARGE THIS LIMIT. YOU AGREE THAT 

OUR SUPPLIERS WILL HAVE NO LIABILITY OF ANY KIND ARISING FROM OR RELATING TO THESE TERMS 

OF USE. 

 

SOME JURISDICTIONS DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL 

OF CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU. 


